Sesion 3 de ejercicios EJB - Beans de
sesion sin estado con BEA Workshop

indice
1 Instalacion y puesta en marchadel SErVIdor ........cccovevvieericce e 2
g 10w (o I o 11 = PSS 3
3 Creacion del enterprise bean SAlUTO..........coereeiiieeee s 5
4 PruebadelosclienteS del DEAN...........coveei i 8
5(*) Creacion de laapliCaCion WED...........ccccuiieieieeesese et 8

6 (*) Creaciony despliegue del EAR...........ooee et 10




Sesion 3 de ejercicios EJB - Beans de sesion sin estado con BEA Workshop

En esta sesién de gjercicios vamos a crear €l mismo ejb de sesién gue en la clase pasada, pero
utilizando €l entorno de desarrollo BEA Workshop y €l servidor de aplicaciones BEA
WebL ogic.

WebL ogic permite, yaen laversion 2.1, el uso de anotaciones propias en €l fichero de
implementacion del enterprise bean. Estas anotaciones son procesdas por |as herramientas de
despliegue de WebLogic y € EJB se construye de forma automética a partir de ellas. La
especificacion EJB 3.0 utiliza una estrategia similar, pero con anotaciones estandar.

Pasar de laforma de trabajar con WebL ogic ala especificacion 3.0 es inmediato.

1. Instalacion y puesta en mar cha del servidor

1. Lanzael Workshop y crea el espacio de trabajo Wor kshop en el directorio que desees.
Ese vaaser € espacio de trabajo en el que vas adesarrollar |os proyectos en 1o que queda de
maodulo.

2. Aade el Runtime de BEA Weblogic 9.2 con laopcion "Window > Preferences > Server >
Installed Runtimes > Add...". Selecciona €l runtime que aparece:

W Preferences |._|@@

bypeFiter text = Installed Server Runtime Environments
+- General
& Ant Add, remove, or edit installed server runtime definitions,
+ Data The checked runtime will be used by defaulk when creating new projects,
%1 File Tempiates Installed server runtimes:
+- Help Iame Type | add...
+- Install{Update hea BEA Weblogic v9.2 BEA Weblogic va.2
+- Internet
+-lava

MetlI Page Flaw Q
+- Plug-in Development
+- Run/Debug Search..,
=I Server

Audio
Installed Runtimes

+ Team

“alidation
+)- Wb and XML
+- Wehlogic
+- Wb Services
+| Workshap
+|- #Doclet

3. Unavez afadido €l runtime, pulsa el botén derecho en el panel de servidores para afiadir
un nuevo servidor ("Boton derecho > New > Server"). Introduce el dominio "g/b" que creaste
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en los gercicios anteriores ("Next > Enter Domain home (Browse...)
C:\bealuser_projects\domains\gjb™). Pulsa"Finish".

Pulsa en € botén "Play" para poner en marcha el servidor. Debe quedar en estado de
"Started":

Problems (S 0 Javadoc | Tasks | Console  JUnit & O mER T 0

ot
Republih

l= opened. All server side log events will he written to this file.>
+—2887 B6H12”* CET> <Motice}> <Security> <{BEA-B70082> <Security initializing|
ecurity realm myrealm.
2.37 l6H12 CET> {Notice> {UebLogicS8erver> <BEA-OPA365> {Server state ch|

ZIB'? I6H12 CET> <{Motice> <{UebLogicServer> <BEA-BB@365> {Server state ch

7> {The server init

1a11._ed the dnmam log hl oadcaster successfully. Log mes: s will now he bhroadc
lasted to the domain

2087 B6H13’ GET) (Nutlce) {MebLogic8erver> <BEA-BBBA365> {Server state ch|

2087 B6H13’ CET> {Notice> {UebLogicS8erver> <BEA-BPB365> {Server state ch|
RESUMING>
87 B6HL3! CET) (Notlce) <Server> {BEA-BB2613> {Channel "Default[11" is|
ning on 127.8 7?0881 for protocols iiop. - L - htt

l6H13 CET) (Notlce) {Server>
on 211.55.3:7881 for protoc op. t3, ldap, http.>
ZBE'? BSH13 GET> (Nutlce) (UehLugl r> <BEA-0AB@331> <{8tarted WebLogil

c ﬂdmln Server "AdminServer" for domain “ejh" running in Development Model
[<22-mapr—28@7 B6H13* CET> <{Notice}> <UWebLogicServer> <BEA-OBB365> {Server state ch|
langed to RUMMNING>
(22 mar—2087 B6H13' CET> <{MNotice> <{UebLogicServer> <BEA-BB@36B> {Server started
in RUNHING mode>

2. Proyecto cliente
e —

Vamos ahoraaimportar €l proyecto cliente de la sesion anterior (creado con Eclipse) a
entorno de trabajo Workhsop.

1. Copialacarpetaej b- cl i ent e- sal udo delacarpeta donde esta el espacio de trabgjo
de Eclipse ala carpeta donde has creado el espacio de trabajo de Workshop.

2. Yaen Workshop, crea un nuevo proyecto java ("New > Project... > Java > Java Project").
Introduce como nombre del proyecto el mismo del proyecto que has copiado

(ej b-cl i ent e- sal udo). Apareceraun mensge en € que el Workshop te informa de que
el proyecto ya existey que vaaintentar configurar € build path. Pulsa"Finish" y cambiaala
perspectiva de Java. El entorno mostrara el siguiente aspecto:
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¥ Java - BEA Workshop for, WebLogic Platform E”Elgl

Fle Edit Source Refactor Navigate Search Project Run Window Help
w = #-0-Q- | EFCG- |®F @ [ | &1 i

Hierarchy 2| BgY=0 = 0|5z outline 2 =0

An outline is not available.

B} es.ua.jtech.eib clentes
#-H3 es.ua.jtech.sib bests
+-2, JRE System Library [jdk150_06]
(7 ejb-saludo-tlientiar.jar
() wiclient.jar
=, org.eclipse, jdt.junit, JUNIT_CONTAINER(S.8.1 {unknown)

[Z Problems 52 . Javadoc Declaration | Console | JUnit ¥ =0
2 errors, 0 warnings, 0 infos

| Description Resotrce | In Folder
@ The project cannot be built until build path errars are resolved ejb-clignte. ..
@ Unbound classpath container: ‘org.eclipse, jdt. junit, JUNIT_CONTAINERjZ.8.1 ...  ejb-chiente...
< >

sib-cliente-saluda

3. Aparece un error debido a que no se encuentran las librerias de JUnit. Haz que Workshop
las instal e autométi camente creando un nuevo test y cancelando su creacion después de haber
anadido lalibreriaa build path. El aspecto del proyecto debe ser e siguiente:

o
ech.ejb.clientes
+-[J] ClienteSaludo, java
-1-£3 es.ua.jtech.eib.tests
+-[J] TestSaludo.java
=i IRE System Library [jdk150_06]
=
() ejb-saludo-clientjat . jar
=
() wiclient jar
§| JUNIT_HOMEfjunit jar - C:\bealworksh

EIRES e

4. Prueba ahoraa gecutar €l clientey el test de JUnit. Veras que aparece un error, debido a
gue el enterprise bean no esta desplegado en el servidor.
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W Java - BEA Workshop for WebLogic Platform
File Edit Source Refactor Mavigste Search Project Run Window Help

| [
o
]

Wil = ¥-0-%- | BHG- @@ P B | &sava &
K- an outling is ot avalable,

= IUJ ejb-cliente-saludo
=-HB eswa.jtech ejb.clientes
- [J] ClienteSaludo.java
—-H es.ua.jtech e

+ o
-2, JRE System Library [jdk150_06]
ejb-saludo-clientjar, jar

wiclisnt, jar

| JUMIT_HOME fjunit. jar - C:\bealworksH

11T

®
E

Problems Javado: Deckaration | Console | gfu JUnit 5 4o QR EET O
Finished after 0,531 secands
Runsi 33 B Erors 0 B Falues: 3 |

L
Failure Trace oF

m® Failures | [ Hierarchy

=I- it es.ua.jtech sjb.tests. TestSaluda
g testCreatesaludo
g testSaluda

E testGetsaludo

junik. framewark, AssertionFailedError: Fallo en la creacidn

at es.ua.jtech.ejb.tests, TestSaludo testCreateSaludo( TestSaluda. jav.
at sun.reflect. NativeMethodéccessor Impl.invakeO(Rative Method)

at sun.reflect NativeMethodAccessor Impl.invoke{NativeMethodAccess
= at sun.reflect, DelegatingMethodAccessor Impl.invoke(DelegatingMethc

Y
v
-

>

Puede ser que el bean haya quedado desplegado de |a sesion anterior. En ese caso,
eliminalo utilizando la consola de administracion.

3. Creacioén del enterprise bean Saludo
I

Unavez instalado el servidor de aplicacionesy el proyecto cliente vamos a crear y desplegar
el bean Saludo.

1. Comenzamos creando un proyecto EJB WebL ogic (*Boton derecho en el panel del
explorador de proyectos > New > Project... > EJB > WebL ogic EJB Project"). Escribimos
como nombre de proyecto ej b- sal udo terminamos ("Next > Finish"). El entorno cambiaa
la perspectiva Workshop.

2. Creamos €l paquetees. ua. j t ech. ej b. beans y en é creamos un WebL ogic
SessionBean ("Botén derecho sobre e paquete > New > WebL ogic SessionBean™). Ponemos
como nombre de fichero Sal udoBean:
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W Workshop - SaludoBean. java - BEA Warkshop for WebLogic Platform =1 3]

Fie Edit Source Refactor Mavigate Search Project Run Window Help
Ci-E&|%-0-Q- | EHG- O [[sB |0 [F & -H-w6- & | [@workshop =
[% Package Explorer 52 =N O soiudopeanjava X = O |/E@ annctations 3 . outline =08
= <§> = package es.ua.jtech.ejb.beans: ~ j‘@ =
125 sib-cliente-saluda . SaludoBean - Class Declaration
£-5% efbesaludo #®import javax.ejh.SessionBean:[] Froperty | value A
o s = RoleMappings
= H ss.ua.jtech.efb.beans fmm valug
+ @SaludoBean.iava + <coderGenericSessionBean</code> subclass automaticall = SecurityRolef
(= METAINE id
+ B JRE System Library [BEA Weblogic v¢ * Please flush out the {Alink #ejbCreate()} method, add roleLink
+ i, BEA WebLogic ¥3.2 [BEA Products] % and review the Session, JndiName and FileGeneration = relelame
+ ), Apache XMLBeans * your intended use. = SecurityRoler
= build iy value
[@Session(ejbMame = "SaludoBean”) = Se“"‘“‘ff”dpu
Bdndilame [remote = "ejb.SaludoBeanRemoteHome") :° =5 .
ransactio
ATileGeneracion remoteClass = Constants.Bool.TRUE, remot imotageel
public class SaludoBean extends GensricSessionBean imple S T—
private static final long serialVersioaUID = 1L; prE—
= Servicerefs
/% (non-Javadoe) value
+ @see weblogic.ejb.GenericSessionBeanfeibCreate (] o v
< > < > £ ¥
@) Design Wiew Palette 52 = O ||problems | 4 Servers £3 . Javadoc Tasks | Consols | JUnit &5 | =08
Server | status State |
Giea BEA WebLogic v9.2 Server [eib] [ Started Republish
wiritable Smart Insert | 1:1

3. Vamos aescribir el codigo del bean de sesion. Sera el mismo que tenia el fichero de
implementacion del proyecto Eclipse, afiadiéndole algunas anotaciones. Abre el fichero

Sal udoBean. j ava del proyecto Eclipse ("File> Open File> ...") y copialadefinicion del
array de saludosy los métodos sal uda() y get Sal udo() . No tienes que copiar |os
métodos vacios que implementan lainterfaz Sessi onBean porgue ya estan implementados
enlaclase Generi cSessi onBean extendida por laclase Sal udoBean.

4. Arreglalos errores del build path importando las clases necesarias (j ava. uti| . Datey
java.util.ArrayLi st).

5. Crealaclase Sal udoTOen el mismo paquete que el bean y copia su contenido del
fichero del proyecto Eclipse.

6. Vamos ahora a modificar las anotaciones, para adaptarlas alos nombres que usamos en las
sesiones anteriores. En primer lugar, en laclase Sal udoBean, debe aparecer como nombre
remoto JNDI Sal udoBean:

@ndi Nane(renot e=" Sal udoBean")

Después, los nombres de las interfaces remotay home debemos cambiarlos a"Saludo™ y
"SaludoHome":

@il eGeneration(...
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r enot el assNane=" Sal udo",
r enot eHoneNanme=" Sal udoHone")

Por ultimo, anota los métodos sal uda() y get Sal udo() con laanotacién
@renot eMet hod()

Con esto ya esta definido el enterprise bean.

7. Antes de desplegar e bean, vamos a definir el nombre del fichero cliente gjbjar necesario
para acceder a bean desde un cliente remoto. Pulsa "Boton derecho en gjb-saludo >
Properties > WebL ogic EJB"). Quita el tic "Use default” y escribe el nombre

ej b-sal udo-clientjar.jar.

W Properties for ejb-saludo ‘;lﬁ
type fiter text webl ogic EIB e

Info
Beaninfa Path EWCFags: | W Usedefat
Bulders

1- Flle Templates Jar settings - create tables: [CREATE_ONLY | [ Use default
= I Use default
J2EE Modle Dependenci Jar settings - EJB client jar: | elb-saludo-chentiar jar 58 e
Java Buid Path

e ;ME Jar settings - enable bean class redeploy: [ Use default

- Java Compler Jr settings - cleable warring: [ ¥ Usedefault
Javadoc Location

J5P Design Palette NOTE: Project-level EJB preferences are only used during the IDE build. For exported Ant
Brofle Complisnce and s buid scripts, the @JarSettings annotation must be used and EJBC Flags must be added
Project Facets to the Ant build script.
Project References
Server
Task Tags
Valdation
WebLogic E18
- KDoclet
XMLBeans

< 5 Restore Defaults Apphy

8. Vamos ya a desplegar e bean. Pulsaen el servidor BEA WebL ogic con e boton derecho y
escoge laopcion "Add and Remove Projects...”. Verés el proyecto ej b- sal udo. Afadeloy
finaliza el despliegue. El entorno debe quedar con el siguiente aspecto:
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W Workshop - SaludoBean. java - BEA Workshop for WeblLogic Platform

File Edit Source Refactor Mavigate Search FProject Run Window Help
i = B-O-Q- | BHEG & o @ |F |8 -3-eo- | [Wwerkshop
[ Package Explorer 13 = 8| 4] saludeBean.java 22 . [J] SaludoTo java -8 outine O
| BE < package =3.ua.jtech.edb.beans: = [ e @
+ 1 ejb-cliente-saludo 3 ndiuame - Annctation
= jﬁe]h-sa\udn #®import java.util.ArrayList:[] Property Yalue
SR =
= H es.ua.jtech.ejb. b local UNSPECIFIED
+] @ga\ud B * <ooderGenericSessionBean</code> subclass automatically remote SaludoBean
= [1] SaludoT
# [ META-INF * Please flush out the {@link #ejbCreate()} method, add
@ IRE System Library [BEA WebLogic +9.2 JRE] * and review the $ession, Jndileme and FileGeneration am
- i BEA WebLogic 9.2 [BEA Products] * your intended use.
# i Apache XMLBeans wy
I @& buid Sezsion(ejbName = "SaludoBean”)
15 eib-saluda-clientiar Indilame (remote = "SaludoBean™)
FileGensration (remoteClass = Constants.Bool.TRUE,
remoteHomeName = "$aludoHome ") &
< | B < IE2
@) Design View Palstte 52 O |problems | 4} Servers 22 . Javadoc Tasks Console | JUnit £ 5 R g =8
Server | status | state |
=/ Gieg BEA WebLogic v9.2 Server [ejb] | Starked Synchronized
(& eib-saludo

9. Abre la consola de administracion y comprueba que e bean esta deplegado.

4. Prueba delosclientesdel bean
e

1. Actualizalalibreriaclientjar del bean. Paraello borralalibreria

ej b-sal udo-cl i entjar.jar de proyecto cliente con laopcién "Botén derecho >
Build Path > Remove from Build Path". Copia €l fichero ej b- sal udo-clientjar.jar
del proyecto EJB al proyecto clientey afiddela al build path ("Botén derecho > Build Path >
Add to Build Path").

2. Limpia el proyecto cliente y pruebalaaplicacion clientey los tests de JUnit.

5. (*) Creacion dela aplicacion Web
e —

Vamos ahora a crear la aplicacion web que se conecta a bean de formalocal. Paraello
deberemos:

« Crear e proyecto Web
« Modificar € proyecto EJB para afiadir las interfaces locales a bean

Vamos aédllo.

(o]
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1. Creaun nuevo proyecto Web ("New > Projet... > Web > Dynamic Web Project") con €l
nombrede ej b- sal udoWar . Pulsa"Next" y deja marcadas solo las opciones "Dynamic
Web Module" y "Java" (ver figura). Pulsa"Finish" parafinalizar.

W New Dynamic Web Project @
Select Project Facets ~ @
Facets are units of functionality that can be added to a project, o— 7
Presets: |<custom> j Save
Project Facet Wersion |
[Fl(5 Dynamic Web Module RN
Java 50..
O = Beehive Controls 1.0
[ = Beshive NetLI 1.0
D Java Annotation Processing Suppork 5.0
0= =F 1.1
= »=n 1.1
O = struts 1.2..
#-[ = web Services
[ = webDaclet (sDaclet) 1.23..
[0 = weblogic Control Extensions 9.2.0
O ‘WwebLogic Integrated CommonsLogging 9.2.0
O WebLogic \Web App Extensions 9.2.0
#-[E 2 #MLBeans
<< Show Runtimes
< Back | Mext > | Finish | Cancel |

2. Creadl paguetees. ua. j t ech. ej b. del egat es en & que copiaras €l JavaBean que
accederaal EJB. Paraello crealaclase Sal udoBean en el paquetey copiael contenido de
laclase Sal udoBean del proyecto Eclipse.

3. Arreglalos errores de librerias afladiendo el proyecto EJB en el build path ("Build Path >
Configure Build Path" y en la pestaia "Projects’ pulsar "Add... g/b-saludo”).

4. Para afadir €l carécter local a EJB basta con afiadir |as siguientes anotaciones:

« Enladefinicion delaclase Sal udoBean, afiade el nombre local INDI y los nombres de
las clases locales:

@ndi Nane(. ..
| ocal =" Sal udoBeanLocal ")
@il eGeneration(...
| ocal d ass=TRUE
| ocal d assNanme=" Sal udoLocal "
| ocal Hone=TRUE
| ocal HoneNane=" Sal udoLocal Hone")

« Enlosmétodossal uda() yget Sal udo() afiadelaanotacion @.ocal Met hod() .




Sesion 3 de ejercicios EJB - Beans de sesion sin estado con BEA Workshop

5. Graba el bean y veras como desaparecen |os errores en g/b-saludoWar (no hace falta crear
de nuevo €l gbjar cliente porque se va acceder al bean de formalocal y los ficheros class
estan disponibles en el servidor).

6. Copiael ficheroi ndex. j sp del proyecto Eclipse a directorio WebContent.

6. (*) Creacion y despliegue del EAR
I

Unavez creado & proyecto War vamos a guardar ambos en un proyecto EARy a
desplegarlos en e servidor de aplicaciones.

1. Creamos un proyecto EAR ("New > Project > J2EE > Enterprise Application Project”) con
el nombrede ej b- sal udoWebEAR. Afiadimos a proyecto los médulos EJB
(ej b- sal udo) y WAR (ej b- sal udowar):

W New EAR Application Project @
J2EE Modules to Add to the EAR —
Select the J2EE modules to add to the news EAR. application from the list. =]

Select Mew Module button to create a new J2EE module,

O ejb-cliente-saludo
eib-saludo
eib-saludo'War

Select Al | Deselect All Mew Module...

Content Directory:

EarContent

< Back ‘ Finish | Cancel

2. Eliminael médulo EJB dél servidor.
3. Afade el modulo EAR ej b- sal udoWebEAR a servidor.

10
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aludoBean. java - BEA Workshop for WebLogic Platform
Fle Edt Source Refactor Nawigate Search Projeck Run lindow Help

= 5 -
Cil F-0-%- | BHFEG- | @S 9 |F LACRCI | [workshop =
M [3] saludoBean java 52 SaludoTonjava [1] SahudoBesn java 1 = 0@ annotations 22 . outine| = O
IEEs IR a_ * v
5 & o chente-saiudo * Please flush out the {@link #ejbCreate(]} msthod, add all des: FieGanaration - Annatation
53 sl * and review the Session, Jndilame and FileGenerarion annotatio: Feaia7 CEIE
=3 s * your intended use. = FileGeneration
= H es.ua.jtech.gjb.beans A4 localClass TRUE
- (B SaludoBean java “BSession{ejbMeme = "SaludoBean') localClassMami SaludoLocal
- [J] SaludoTo.java BondiNames (rewote = "SaludoBean, local = "SaludoBeanLocal™) localHome ~ TRUE

localHomeMam SaludoLoca
localHomeRack UNSPECIFIED
localPackage  UNSPECIFIED
— pkclass TRUE
remoteClass  TRUE

@FileGeneration(remoteClass = Constants.Bool.TRUE,
remoteHome = Constants.Bool.TRUE,
loealClass = Constants.Bool. TRUE,
localHome = Constants.Bool.TRUE,

(= META-INE
* mh JRE System Library [BEA WebLogic v3.2 JRE]
#)mh BEA Weblogic v9.2 [BEA Products]

* @k Apache XM Beans

- buid remoteclassNewe = "Saluda”,
5] efb-saludo-clentiar.jar Feretomelame = "HaladoHome " remateClasshla Saludo
5w e .
&> eib-saludowar localHomeNswe = "SaludoLocalHome", rematetiome | TRUE
=2 sre 1 T —— p——) aw remoteHomeN: SaludoHome
E-f es.ua.jtech.ejb.delegates - ocalClassieame = "Saludolocall) = remoteHomeP: UNSPECIFIED
5 [0 Soobom e public olass SaludoBean extends GenericSessinnBean implements Se: rermoteP ackags UNSPECTFIED
% i JRE System Library [BEA Weblogic v3.2 JRE] private static final long serialVersionlID = 1L: valueClass  UNSPECIFIED
private String[] saludos = { "Hola, cque tal®”, "Cuanto tiempo valusClassNar UNSPECIFIED

% mh BEA WebLogic v3.2 [BEA Products]
+ -z Apache ¥LBeans
= Web App Libraries

"Que te Cuentas?, "Me alegro de VOlVEr & Verte');

- buld . © /7 (non-Javadoc) ~
% (= WebContent < > < =
= 5 eib-saludowebEAR =
? Problems | #l Servers 3 Javadoc Tasks |Console Junic S g % mE0 70
Server | status State |
= thea BEA Weblogic v3.2 Server [eb] 7 Started Synchronized
# (5 efb-saludoWebEAR
< |
{@) Design View Palstte 52 =0

EarContent - ejb-saludoWebEAR

4. Comprueba que funcionala aplicacion Web conectandote ala URL
http://1 ocal host: 7001/ ej b- sal udoWar/ :

) Saludo - Mozilla Firefox

frchive  Editar Wer  Historial  Marcadores  Herramienkas  Ayuda

= - @ g |u hitp: fflocalhost: 7001 fejb-saludowar|

# comenzar ausar Fire. . (52 Oltimas noticias

|| BEA WebLogic Serwer Administration C... || saludo 8

Saludo

+ Mensaje: Cuanto tempo sin verte
+ Fecha de creacién: Thu Mar 22 07.38:53 CET 2007
* MNumero de datos: 100000

5. Por ultimo, pruebadl cliente remoto y el test JUnit para comprobar que lainterfaz remota
del EJB sigue funcionando.

11
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